CONTOH KASUS ARIMA MENGGUNAKAN EVIEWS

Pada suatu dealer motor diketahui ternyata pemilik owner tersebut ingin meramalkan
penjualan motor Suzuki selama 5 bulan kedepan dengan menggunakan data penjualan
motor suzuki sebanyak 80 observasi dari bulan desember 2011 sampai bulan Juli 2018.
Data tersedia di Lampiran excell dengan nama “datamotor”.

Langkah-langkah dalam analisis ARIMA

Import data

Buka workfile baru dengan cara File > New > Workfile. Maka akan muncul tampilan
seperti berikut yang digunakan untuk menentukan deskripsi data.

=

Workfile Create I&

Workfile structure type Date specification

Dated - regular frequency - Frequency: |M°|'Iﬁ'l|3" - |

Irregular Dated and Panel

workfiles may be made from Startdate: | 201112
Unstructured workfiles by later

End date:
spedfying date andjfor other nd da 2018 12|

identifier series,

Warkfile names (optional)
WF:

Page:

Ok ] | Cancel

Workfile structure type : digunakan untuk menetukan struktur data. ada 3
jenis struktur:

- unstructured/undated : tidak struktur atau tidak ditentukan waktunya
untuk data time series.



«Dated: menentukan waktu data untuk data time series.

-Balanced panel: menentukan data  untuk data  panel

Karena kita sudah mengetahui periode data yang digunakan maka kita
memilih Dated

Date specification: karena data yang digunakan bulanan maka kita memilih
monthly.

Start date: isilah periode awal dari data yang akan digunakan

End date : isilah periode akhir + periode yang akan diramal dari data yang
akan digunakan. Pada kasus ini periode akhir Juli 2018+5 bulan data yang
akan diramal. Sehingga pada end date diisi Desember 2018.

« setelah itu akan muncul tampilan berikut.

s
[0 Weorkfile: UINTITLED o |[=][=
\'lm_l”rv:_ﬂwul | Swve F:nu_behlh*-'- Sth_Fn:h_Hur_Drklr Geni| Sample
Range: 2011W12 2018M1Z = 850l Filer. "
Zample: 2011012 2018M12 — 85008 Cader. Hame
E «c
& resid

vi Untithed | Hew Page

« Masukkan/import data series yang terdapat pada file ihsg arima.xls dalam Workfile
di EViews. Caranya pilih File > Import > Import from file. kemudian pilih data maka
muncul jendela seperti berikut.



ﬁhm.ﬁaﬁmmhhmd&m © Dedmvier chavacters between values

the Firwsh button to read your data indo EViews, ) Poned width fields
romnmmm-a\mmm A et format (1o be provided)
the lst on the rght,, then dick Next to continue.
To adjust e rom bresks, dick on the folowng Mdm.
Show fow 0pb Spnes: 0 -

Paziode | Memts Yamany 3
11-Dec | 292009 233433
13-2an | 30363 306704

al -

46305% ‘Ji
65260 =3

(A3-Teb | INSTEQ IER4NY 70787

A3sMax | 325904 24710

L3-Apr | 344340 226204

13-May | 363137 I0150N

22-va | 333373 16766Y

23362 | 34473 05T

32-Asg | 263234 234020

[32-5ep | 371TEN 0004

LHTLL
€22929
€15047)
550464
S05659

43374
620739

(Tampilan diatas muncul dikarenakan data dalam format csv)

« Selanjutnya tekan next sampai terdapat tampilan sebagai berikut

Text Read - Step 4 of

Structure of the Data to be imported -
Basic structure Frequency/date specfication
| Dated - regular frequency v|  Frequency: | Monthiy v

Import method

Dated read v
Import options -
Startdate: | 201114

DERIODE HONDA |  YAMAHA SUZUKI | KAWASAKI VS
2011M12  11i-Dec 28200 133431 4027 €001 a
2012M01  12-Jan 38263 206704 5333 8563 3
2012M02  12-Feb 35576 258481 4433 10734
2012M03  12-Mar 32599 247103 4002 12198
2012M08  12-Apr 34434 23618 3038 5717
2012M05  12-May 36212 20158 3636 13093
2012M06  12-Jun 33227 16766 3653 1213
2012M07  12-Jul 34473 18578 4289 uu; -
2012M08 <l T ] >
S20135M008

Pada start isi lah periode awal dari data. Misal pada studi kasus ini data dimualai
dari bulan Desember 2011 maka diisi dengan 2011 12. Setelah diisi klik finish.

Identifikasi Model



Pada studi kasus ini kita menggunakan data Suzuki maka klik dua kali untuk data

Suzuki. Dan selajutnya menghasilkan tampilan sebagai berikut:
0 -
£5 Series: SUZUKI Workdile: UNTITLED:Untitled\ E=REcy ===
[VIQWIPIOC | Object | Properties | iPnnt jNamejﬂetzeJ | Defauit -l ISon[Edn-/—jSmpl-
Suzuki
Lastupdated 11/02/18 - 11.01 -
| Imported from ‘C\Users\Toshiba\Desktopidatamotor.csv
201112 40279
2012M01 | 53337
2012002 | 44335
2012103 40026
2012M04 30385
2012M05 | 36386
2012M06 | 36532
2012M07 42894
2012108 27445
2012109 35882
2012110 42874
2012M11 38965
2012012 32005
2013401 | 35758
2013402 | 37720
2013M03 28286
2013M04 | 33564
2013405 32768
2013106 45315 -
2013407 | « ,

« Setelah ini kita akan melakukan langkah-langkah menetukan pengujian. Sesuai yang
dijelaskan sebelumnya ada 2 cara untuk menentukan data stasioner atau tidak. Maka
pada tahap ini kita akan mencoba satu-satu.

» menggunakan Grafik

Pilih view, kemudian graph lalu tekan OK. Maka akan muncul grafik data Suzuki
sebagai berikut :



f Sevies: SUZUKT Warkfile: UNTITLED: Untithed, |_:.HEI_@
[Mlhn:Iﬁthd.[ﬁupmusJ lleI!l hl.lmtIFruar] |Ddu,l - | [(;Iptlnns |$am;-|E

Suzula
£0,000
mnﬂu-ﬁ
40,000 -
30,000 - f )\I,'
20,000 < \\
10,000 - ‘—\M
V’“NAMM
LA L

Fath I 1 3 013 014 Fas) b 018 Pl 018

Berdasarkan gambar diatas terlihat bahwa adanya indikasi data tidak stasioner pada
rata-rata. Hal itu terlihat dari grafiknya trend menurun.

Untuk menentukan model arima (p,d,q), terlebih dahulu kita menentukan nilai d
dengan uji stasioneritas terlebih dulu. Langkah-langkahnya sebagai berikut :
Menggunakan uji ADF

Hampir sama dengan sebelumnya, tekan view lalu pilih unit root. Selanjutnya akan
muncul tampilan sebagai berikut.

L hl
Unit Root Test ﬁ

Test type
Augmented Dickey-Fuller -
Test for unit root in Lag length
@ Lewvel .
— EUE_ @ Automatic selection:
[ ] () 1st difference
) 2nd difference Schwarz Info Criterion v]

[ Maximum lags: | 11

Indude in test equation
@ Intercept

71 Trend and intercept .
I () User specified: 2
) Mone -

[ oK ] [ Cancel ]




Kemudian tentukan metode apa yang digunakan. Karena kita menggunakan ADF
maka pilih Augmented Dickey-Fuller. Lalu pilih level pada test for unit root in dan
pilih intercept pada include in test equation. Lalu tekan ok. Hasil uji ADF adalah

sebagai berikut:

Mull Hypothesis: SUZUKI has a unit root

Exogenous: Constant

Lag Length: 2 (Automatic - based on SIC, maxlag=11)

t-Statistic Prob.*

Augmented Dickey-Fuller test statistic -1.952892 0.3069
Test critical values: 1% level -3.517847
5% level -2.899619
10% level -2.587134

Berdasarkan output ADF ternyata p-value=0.3069>alpha=0.05 maka Terima HO yang
artinya data mempunyai unit root (data tidak stationer).karena data tidak stationer
pada rataan maka dilakukan differencing 1 kali. Oleh karena itu kita ulang kembali
pengujian. Sama dengan sebelumnya, tekan view lalu pilih unit root. Selanjutnya

akan muncul tampilan sebagai berikut.

-

Unit Root Test

e

Test type

Augmented Dickey-Fuller

Test for unit root in
Level
@) 1st difference

2nd difference

Indude in test equation
@ Intercept

Trend and intercept
Mone

Lag length

@ Automatic selection:

Schwarz Info Criterion -

Maximum lags: | 11

Lser specified: 2

0K ] | Cancel

Karena kita akan melakukan differencing 1 kali maka kita pilih 1= difference. Lalu

tekan ok.



Mull Hypothesis: DISUZUK]) has a unit root
Exogenous: Constant
Lag Length: 0 (Automatic - based on SIC, maxlag=11)

f-Statistic Prob.*

Augmented Dickey-Fuller test statistic 1232284 0.0001
Test critical values: 1% level -3.516676

5% level -Z.899115

10% level -2 586866

Berdasarkan output ADF ternyata p-value=0.0001<alpha=0.05 maka Tolak HO yang
artinya data tidak mempunyai unit root (data stationer). Karena data sudah stationer
pada differencing 1 kali maka kita sudah bisa melanjutkan analisis.

Langkah berikutnya adalah menentukan p dan q untuk parameter ARIMA dengan
cara melihat pola fungsi autokorelasi(ACF) dan autokorelasi parsial(PACF) dari
data. Untuk itu dari pengujian ADF tadi jangan di close dulu. Pilih view
> Correlogram sehingga tampil kotak dialog seperti pada Gambar di bawah.

Correlogram Specification &

Correlogram of
Level

0 1stdifference | g OK
2nd difference

Lags to indude ’7@*

Karena data kita stationer pada differencing 1 kali, maka kita pilih 1« difference lalu
tekan ok. Selanjutnya akan muncul tampilan sebagai berikut.



Date: 11/02M18 Time: 11:32
Sample: 201112 2018M12
Included observations: 79

Autacarrelation Parial Correlation AC PAC OQ-Stat Prob

-0.280 -0.280 6.4273 0.011
-0.152 -0250 8.3480 0.015
-0.165 -0.334 10644 0.014
0.244 0030 15717 0.003
-0.085 -0.105 16.236 0.006
-0.004 -0.046 16338 0.012
-0.087 -0.090 17.017 0.097
0.097 -0.030 17.861 0.022
0136 0182 19543 0.021
-0.230 -0.165 24.444 0.007
0.098 0108 25341 0.008
0.066 0106 25756 0.012
0.076 0094 26321 0.015
-0.237 -0.046 31.865 0.004
0.065 -0.031 32293 0.006
0.036 0028 32422 0.009
0.085 -0.005 33171 0.011
-0.030 0103 33.266 0.015
0.025 0.146 33331 0.022
0.051 0131 33614 0029
-0.118 -0.050 35138 0.027
-0.033 -0.051 35263 0.036
-0.000 -0.026 352632 0.049
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dari plot autokorelasi(ACF) dan plot autokorelasi parsial(PACEF), terlihat bahwa
kedua gambar mengalami cut off(turun drastis) seperti ditunjukkan pada kotak
orange. Pada plot ACF terlihat bahwa pada lag 1 signifikan dan cutoff pada lag 2 dan
3 lalu signifikan kembali pada lag ke 4. Sedangkan pada plot PACF terlihat bahwa
pada lag 1,2 dan 3 signifikan dan cutoff pada lag 4 dan seterusnya. Maka terdapat 3
kandidat model yang sesuai untuk studi kasus ini yaitu ARIMA (3,1,0), ARIMA(0,1,1)
dan ARIMA(3,1,1).

Pendugaan parameter

Karena kita mempunyai 3 kandidat model maka kita akan melakukan dugaan
parameter satu persatu. Pertama dimulai dengan model ARIMA (3,1,0).

langkah selanjutnya adalah pilih Quick > estimate equation. sehingga akan muncul
tampilan sebagai berikut.



r l
Equation Estimation -— e ﬂ
|

Spedfication | Options |

Equation spedfication

Dependent variable followed by kst of regressors induding ARMA
and POL terms, OR an explct equation le Y =c{1)4+c(2)"x.

disundd) ¢ ar(1 to 3

Estimation settings

Method: 15 - |sast Squares (NLS and ARMA) -

Sample: | 3011m12 2018m12

[_oc [ concel

pada equation specification untuk diisi dengan urutan seperti gambar diatas berikut
penjelas:

4.

7.

suzuki : sebagai nama data yang digunakan. kemudian jika data stationer saat
dilakukan differencing maka pada data ditambahkan d(). Contoh untuk d=1 maka
menjadi d(suzuki), jika d=2 maka menjadi d(d(suzuki)), dst. Karena pada kasus
ini dilakukan  differencing 1 kali ~ maka  ditulis d(suzuki).

c: sebagai konstanta, setelah nama data harus diisi c sebagi konstanta,

ar() : sebagai ordo p,q yang sudah kita tentukan. ar menyatakan nilai p dan ma
menyatakan nilai q. Karena kita ingin menduga parameter model ARIMA (3,1,0)
maka ar=3 sehingga ditulis ar(1 to 3).

Setelah itu klik ok, maka akan muncul hasil seperti berikut.



(=) Equation: UNTITLED Worldite: UNTITLED:Untitled\ —
l[\mw[»m[omnﬂlvm]nne]mmﬂnmn[fomm]mn]mm

Dependent Vanabie D(SUZUKI)

Hethod ARMA Mavmum Likeihood (OPG - BHHH)

Date: 110218 Time. 1215

Sample: 2012M01 2018M07

Inchuged obsenatons 79

Convergence achkeved afer 21 iterations

Coeficent covanance computed using outer product of gradients

Varable Coeficient  Sta Eror F&P“—“Of

Cc -470.0070 2222567 -21WT03 0.
AR(1) 0456876 0008299 4 0
AR(2) 0386168 0091820 4 0.
AR(3) 0359368 0097624 -3
SIGMASQ 16694764 2544386 8561411 0,0000
. R-squared 0251532 Mean depencent var ~400.5063
Adjusted R-squared 0211075 S0 dependent var 4753023
SE ofregression 4221704 Axaive Info crtenon 1660314
Sum squared resid 1326+09 Schwarn crtenon 19.75310
Log likelihood ~789.3239 Hannan-Quinn criter. 1966322
F-statistic 6217172 Durdin-Watson stat 1827663
Prod{F-statistic) 0000228
Invented AR Roots 172 1172 -87

Pada output diatas terlihat bahwa semua parameter signifikan, dan AIC nya sebesar
19.60. Nilai pada Box orange merupakan dugaan parameternya.

8. Selanjutnya lakukan langkah-langkah yang sama untuk 2 kandidat model
lainnya. Output kandidat model kedua dan ketiga sebagai berikut.

B o). el

. \ RO X »
[ view]proc opject] [ print | Hame [Freeze | [Estimate | Forecast| stats [Resias |
| Dependent Variable: D(SUZUKI)

Method: ARMA Maximum Likelinood (OPG - BHHH)

Date: 11/02/18 Time: 12:19

Sample: 2012M01 2018M07

Inciuded observations: 79

Convergence achieved after 6 iterations

Coefficient covaniance computed using outer product of gradients

Vanable Coefficient  Std Error t-Statistic Prob.
c -475.3001 2124514 2237218 0.0282
MA(1) -0.589308  0.106230 -5547457  0.0000
SIGMASQ 18178556  2285665.  7.953291 0.0000
R-squared 0.185010 Mean dependentvar -400.5063
Agjusted R-squared 0.163563 S.D. dependentvar 4753.023
SE. ofregression 4346968 Axalke info criterion 19.63498
Sum squared resid 144E+09 Schwarz criterion 19.72496
Log likelihood -772.5817 Hannan-Quinn criter. 19.67103
F-statistic 8.626365 Durbin-Watson stat 1.656769

Prob(F-statistic) 0.000421

Inverted MA Roots 59




Output diatas merupakan kandidat model ARIMA(0,1,1) terlihat bahwa semua
parameter signifikan, dan AIC nya sebesar 19.72.

?E] Equation: UNTITLED Workfile: UNTITLED:Untitled\ o l-a .Al'“
[Vlewl Proc IObjed ﬂ Print I Namel Freeze ﬂ Estimate[ F oreastl Statsl Resids ]

Dependent Vanable: D(SUZUKI)

Method: ARMA Maximum Likelihood (OPG - BHHH)

Date: 11/02/18 Time: 12:20

Sample: 2012M01 2018M07

Included observations: 79

Convergence achieved after 24 iterations

Coefficient covariance computed using outer product of gradients

L)

Variable Coefficient Std. Error t-Statistic Prob.
C -471.8383 2406884 -1.960370 0.0538
AR(1) -0.714285 0.281954 -2.533336 0.0134
AR(2) -0.475872 0.122752 -3.876695 0.0002
AR(3) -0.419016 0.102142 -4.102282 0.0001
MA(1) 0.290050 0.332277 0.872915 0.3856
SIGMASQ 16590552 2582409, 6.424447 0.0000
R-squared 0.256205 Mean dependentvar -400.5063
Adjusted R-squared 0.205260 S.D. dependentvar 4753.023
S.E. of regression 4237.235 Akaike info criterion 19.62270
Sum squared resid 1.31E+09 Schwarz criterion 19.80266
Log likelihood -769.0966 Hannan-Quinn criter. 19.69480
F-statistic 5.029054 Durbin-Watson stat 1.870381

Prob(F-statistic) 0.000515

Output diatas merupakan kandidat model ARIMA(3,1,1) terlihat bahwa terdapat
parameter yang tidak signifikan yaitu MA(1) dan AIC nya sebesar 19.62.

Penentuan model terbaik

Pada penjelasan sebelumnya, untuk menentukan model terbaik dari beberapa
kandidat model kita bisa menggunakan MAPE dan MSE. Namun dikarenakan
eviews tidak memiliki nilai MAPE dan MSE, oleh karena itu kita bisa menggunakan
nilai lain yaitu AIC (akaike info criterion). Model terbaik adalah model dengannilai
AIC yang terkecil.

Model AIC
ARIMA (3,1,0) 19.60
ARIMA (0,1,1) 19.72
ARIMA (3,1,1) 19.62




Berdasarkan nilai AIC ternyata nilai AIC terkecil berada pada model ARIMA
(3,1,0). Maka model terbaik dari ketiga kandidat adalah model ARIMA (3,1,0).
Tahapan selanjutnya akan menggunakan model ARIMA (3,1,0).

Pemeriksaan diagnostic

Setelah menduga parameter, langkah selajutnya dilakukan Pemeriksaan diagnostic
yang dibagi menjadi dua bagian yaitu Uji signifikansi parameter dan uji asumsi
residual. Hal ini dilakukan karena untuk mengetahui model yang baik bisa dilihat
dari signifikansi parameter dan residualnya. Jika semua dugaan parameternya
signifikan dan residualnya white noise, maka modelnya dapat dikatakan baik dan
sebaliknya.

Pada uji signifikansi parameter, ternyata semua dugaan parameter pada model
ARIMA (3,1,0) sudah signifikan, sehingga signifikansi parameter terpenubhi.

Salah satu cara untuk melihat white noise dapat diuji melalui korelogram ACF dan
PACF dari residual. Bila ACF dan PACF tidak signifikan, ini mengindikasikan
residual white noise artinya modelnya sudah cocok, sebaliknya maka model tidak
cocok.

Caranya dengan pilih View > Residual tests > Correlogram-Q- Statistic. maka akan
muncul output seperti berikut.



Date: 11/02M8 Time: 12:22

Sample: 201112 2018M12

Included obsenations: 79

Q-statistic probabilities adjusted for 4 ARMA terms

Autocorrelation Partial Correlation AC PAC Q-Stat Prob

1 0007 0,007 00035

2 -0.024 -0.034 01004

3 -0.026 -0.025 0.1563

4 -0121 -0.122 1.4140

S -0,092 -0.094 21451 0.143
6 0.063 0.055 24957 0.287
7 -0.036 -0.050 26116 0455
8 0037 0022 27337 0603
9 0162 0145 51582 0397
10 -0.106 -0.105 6.1940 0402
11 0123 0.14F 76226 0367
12 0.050 0047 78575 0.448
13 0003 0.052 7.8582 0548
14 -0.153 -0151 10151 0.427
15 0.027 0037 10223 0510
15 0.044 0098 10422 0579
17 0129 0109 12138 0516
18 0.097 0.086 13134 0516
19 0.044 00689 13342 0576
20 0,000 -0.003 13342 0.648
21 -0.137 -0.106 15414 0566
22 0077 -0.056 16.087 0586
23 -0023 0.025 16145 0.648
24 0033 -0.031 16274 0699
25 -0.059 -0.089 16691 0730
26 -0.003 -0.057 16693 0.720
27 -0106 -0.143 18075 0.753
28 0046 -0.031 18342 0.786
29 -0.025 -0.083 18419 0824
30 -0.056 -0.066 18.826 0.844

Dari output diatas terlihat bahwa dari lag 1 sampai ke 30 tidak ada lag yang
signifikan. Artinya tidak ada korelasi antar residual, residual sudah homogen
dan tidak ada pola pada residual. Hal ini menandakan bahwa residual sudah
white noise sehingga bisa dikatakan model sudah cocok.



Berdasarkan grafik diatas menunjukkan bahwa residual sudah normal yang
ditunjukkan dengan bentuk seragam yang simetrisdan berbentuk lonceng serta
diperkuat dengan hasil uji Jarque-Bera dimana p-value=0.15> alpha-0.05 maka

12

o

3000

LI |
12000

Senies: Residuals
Sample 201201 2018M0T
Observations 79

Mazn BZ.18122
Medizn -53 40782
Mazginmm 1186639
Miininmwm -S35R 253
Std. Dev. 4111658
Skewness 0.325104
Hurtosis 3. B487THT
Jargque-Bera  3.783120
Probability 0.152352

terima H) yang artinya residual sudah berdistribusi normal.

Forcesting

Setelah memperoleh model yang sudah baik atau sesuai, langkah selanjutnya yaitu
melakukan peramalan (forecasting). Jangan close window untuk model ARIMA (3,1,0).

Pilih proc > forecast lalu akan muncul tampilan sebagai berikut:

r

= R —— b
Forecast @
Forecast equation
UNTITLED
! Series to forecast
i Q' SUZUKI D(SUZUKT)
|
Series names Method
| Forecastname: | suzukif @ Dynamic forecast
Static forecast
S.E. (optional): %
Structural (ignore ARMA)
V| Coef uncertainty in S.E. calc
Forecast sample Output

2011m12 2018m12

v/ Forecast graph
v | Forecast evaluation

V| Insert actuals for out-of-sample observations

(o ]

Cancel




Lalu tekan OK. Maka di workfile akan muncul 1 variabel yaitu suzukif sebagai berikut

[7) Workfile: UNTITLED [o e x=

|view | Proc| Object | | save | Freeze | Details~/- | | show | Fetcn| store | Delete | Genr | sample |
Range: 2011M122018M12 — 85 obs Filter: *
Sample: 2011M12 2018M12 — 85 obs Order: Name

& c

EA honda
kA kawasaki
@5 periode
BA resid
kA suzuki
BA suzukif
kA total

B s

kA vamaha

4 v} Untitled | New Page [

Maka ramalan penjualan motor Suzuki untuk 5 periode kedepan adalah sebagai berikut
klik variabel suzukif)

2018M08 | 6612365
2018M09 | 6142358
201810 | 3672371
2018N11 2202344
201812 | 4732337

SEKIAN TERIMA KASIH



